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1 Using This Guide      

Introduction      
The PDA software provides functionality to extract and analyze spectral data from 
Diode Array Detectors using the EZChrom Elite data system.  

Who Should Read This Guide?      
This document is designed for users of the PDA software. 

Documentation Conventions      
The following conventions are used in this guide. 

 

Convention Description 

Bold Database names, table names, column names, menus, 
commands, dialog box options, and text that must be typed 
exactly as shown. 

Italic Placeholders for information you must provide. For example, if 
you are instructed to type ServerName, then you must type the 
actual name of the server instead of the italicized term. 

Monospace Programming code samples and display text. 
ALL CAPITALS The keys you press on the keyboard. If combined with a plus sign 

(+), press and hold the first key while you press the remaining 
key(s). For example, press SHIFT+TAB. 
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2 About the PDA Software 
The PDA software enables you to view and analyze spectra generated with a photo 
diode array detector on your LC. In order to use the PDA analysis software, you must 
have control software installed for your LC that contains PDA detector capabilities. 

To turn on the PDA analysis option, 

1. Open an instrument configuration. 

2. In the Instrument Configuration window, click Configure. 

3. In the available/configured modules configuration window, click Options. 

4. Select PDA and then click OK. 

5. Configure a PDA detector for your LC instrument.  For details on 
configuration of your particular instrument, see the control help for that 
instrument. 

6. In the Instrument Window choose PDA Options from the Method menu to 
set post-run PDA analysis parameters.  Note that data acquisition 
parameters for the method may need to be set in Instrument Setup 
according to the requirements of the control software for your PDA 
detector. 

Once the PDA analysis software has been turned on, you can 

• View spectra and chromatograms in a variety of formats. 

• Create and search spectral libraries. 

• Perform on-demand peak purity calculations and program peak purity 
calculations to occur as part of analysis.  

• Set up spectral filtering and extract spectra from 3D data. 

• Set Multi-Chromatogram Options 

• Set up chromatogram ratios. 

• Create custom PDA reports. 

3 About PDA Views 
The PDA views provide a variety of ways to view PDA data. You can choose to display 
one view at a time, or a combination of views, such as 3D and Contour or Mixed with 
3D.  

To select the view, choose PDA View from the View menu or by selecting Views from 
the PDA Toolbar.  A right mouse click within any of the view windows provides a 
unique menu of options for that view.  You must have a data file open in order to 
access PDA Views. 

Mixed View

3D Views

Contour View

Max Plot View

Chromatogram View

Multi-Chromatogram View
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Spectrum View

Ratio View

 

About the PDA Toolbar 
Whenever one of the PDA Views is selected, a toolbar will appear with one or more 
menus and buttons that enable you to manipulate the view or perform various actions. 

   

Click Views to select or change the current PDA View. 

Click Synchronize to synchronize the axis and zoom limits with the other two plots. 
When the contour plot is zoomed, the time range of the chromatogram and the 
wavelength range of the spectrum plot are automatically adjusted to the same range as 
the contour. When synchronized zooming has been performed, the x axis plot limits for 
the chromatogram and spectrum plot are changed. To unzoom these plots to the limits 
of the data, you must select Full Unzoom from the contour plot context menu. 

Click Arrange to restore the view windows to default positions.  Use this after you 
have resized the windows by clicking and dragging the window borders. 

The Overlay button appears when a Multi-chromatogram view containing multiple 
chromatograms is displayed.  This toggles between chromatogram overlay view and 
separate chromatogram view. 

Click Actions to open the Actions menu. 

Click Options to open the Options menu. 

 

About the 3D View 
The 3D View provides a three-dimensional view of absorbance versus time and 
wavelength. Wavelengths of appreciable absorbance and interference, which may be 
invisible in a single wavelength plot, are easy to locate with the 3D View. The plot can 
be elevated and rotated around its axis for display from any angle. 

 

Note: During a run, the user must manually refresh this display. It does not update automatically. 
Right-click inside the 3D view to display the pop-up menu that gives you access to plot 
rotation and axis setup features.  
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3D Plot movement selections 
Click on the type of plot movement you wish to use (elevate, roll, rotate, rotate 
XYZ, or spin). A checkmark will appear next to the selected movement option. 
Once you have selected one of the options, you will be returned to the plot and 
the cursor will indicate the type of movement selected. 

 

Hold down the left mouse button and move the cursor in the direction you wish 
to move the plot. The plot will move as you move the cursor. The movement 
option will remain in effect until you turn it off. When finished, click the right 
mouse button, and de-select the movement option. If you wish to return to the 
original view, select the Reset command. 

Note: These values can be viewed or changed using the 3DPlot/Properties dialog. 

Set the 3D Properties 
To set or change the properties of the 3D data display, 

7. From View menu, select PDA View. 

8. Select Mixed View or one of the other views that includes 3D. 

9. Do a right mouse click on the 3D view and select Properties. 

10. Click the General tab to enter or change the properties for the 3D plot. 
 Click the Axis Setup tab to set or change the axis parameters. 
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Style 
Select Color or Grayscale for the plot. Checking the Wire Mesh box will cause 
the data to be rendered as a wire frame plot, rather than as a solid fill plot. 

Colors 

Range 
Select how you want the coloration on the plot to appear. When Light & Dark 
Range is selected, alternating light and dark bands are used. When Full 
Spectrum is selected, then a continuous color spectrum is used. 

Background 
Select the color for the background of the plot. 

Axes 
Select the color for the plot axes. 

Display 
This specifies the relative quality of the displayed contour plot. Lower Display 
Detail will result in faster drawing of the plot. 
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Print  
This specifies the relative quality of the printed contour plot. Lower Print 
Quality will result in faster printing. 

Viewing 
Use these fields to view current rotation settings, or to set them manually. 

Light source 
Selecting this option causes the plot to be shaded as if an external light source 
were shining upon it.  

Rotation 
This reports the current level of rotation (front to back) in the aspect position 
of the plot. When a new value is entered, the plot is redrawn to reflect the new 
value upon exiting the dialog.  

Elevation 
This reports the current level of tilt (forward or backward) in the aspect 
position of the plot. When a new value is entered, the plot is redrawn to reflect 
the new value upon exiting the dialog. 

Roll 
This reports the current level of roll (side to side) in the aspect position of the 
plot. When a new value is entered, the plot is redrawn to reflect the new value 
upon exiting the dialog. 

Zoom 
This reports the current level of magnification in the plot. When a new value is 
entered, the plot is redrawn to reflect the new value upon exiting the dialog. 

Performance - Use Zoom/Rotate Bounding Box 
When this box is checked, the plot will be temporarily replaced by a box during 
zoom and rotation operation. When the operation is completed, the plot will be 
redrawn. Checking this box will increase performance on computers with 
slower graphic subsystems. 
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Set the 3D Axis Properties 
To set the axis properties for the 3D plot, 

1. From View menu, select PDA View. 

2. Select Mixed View or one of the other views that includes 3D. 

3. Do a right mouse click on the 3D view and select Properties. 

4. Click the Axis Setup tab to enter or change the axis properties for the 3D plot.  
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Limits 
Enter the limits for the 3D plot. 

Time 
Click Autoscale if you want to have the software automatically scale the time 
axis to the maximum values. To enter a manual range, de-select the autoscale 
box, and add your own limits, or click the Get Limits button to enter the limits 
displayed on the current 3D graph. 

Wavelength 
Click Autoscale if you want to have the software automatically scale the 
wavelength axis to the maximum values. To enter a manual range, de-select the 
autoscale box, and add your own limits, or click the Get Limits button to enter 
the limits displayed on the current 3D graph. 

Absorbance 
Click Autoscale if you want to have the software automatically scale the 
absorbance axis to the maximum values. To enter a manual range, de-select the 
autoscale box, and add your own limits, or click the Get Limits button to enter 
the limits displayed on the current 3D graph. 
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Labels 
You can customize the labeling of the 3D plot using the parameters in this area. 
You can select font, size, color and style using the selections provided. 

Rotate the 3D plot 
A right mouse click on the 3d plot provides a menu containing various rotation 
options. When you select one of these rotation options, a checkmark will 
appear next to the option and that rotation option will become active on the 
plot.  

 

The cursor will change to indicate the option is in effect. 

 

While the option is active, you can move the plot in the designated way by 
holding down the left mouse button and moving the mouse in the desired 
direction on the plot. When you have the plot in the desired position, click the 
right mouse button and turn off the option by selecting it again (checkmark 
removed). If you want to return to the original plot view, click the right mouse 
button and select Reset. 

About the Contour View 
The Contour Plot (also referred to as an Isoabsorbance Plot) provides an aerial view of 
the absorbance of the sample at each wavelength versus time. The contour view 
supplies quick and easy-to-assimilate information about those wavelengths at which 
the sample exhibits appreciable absorbance. With contour view, it is also possible to 
generate a Chromatogram View for an individual wavelength and a Spectrum View for 
a given point in time. 
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Right-click inside the window to display the pop-up menu. Select Properties to display 
the Contour Properties dialog box. 

To generate a chromatogram view from contour view of Mixed View or Mixed View w/ 
3D: 

1. Select PDA Views from the View menu, and then select Mixed View to 
display the Contour Map, Chromatogram, and Spectrum. 

11. Move the cursor to the triangle-shaped handle located on the left- hand 
wavelength axis of the Contour Map and press the left mouse button. 

12. Drag the cursor up or down to the desired wavelength and release the 
mouse button. 

13. The chromatogram associated with the specified wavelength is displayed in 
the Chromatogram View.  

To generate a spectrum view from contour view of Mixed View or Mixed View w/ 3D: 

14. Select PDA Views from the View menu, and then select Mixed View to 
display the Contour Map, Chromatogram, and Spectrum. 

15. Move the cursor to the triangle-shaped handle located on the time axis of 
the Contour Map and press the left mouse button. 

16. Drag the cursor to the desired peak and release the mouse button 

17. The Spectrum associated with the specified retention time value is 
displayed in the Spectrum View. 

Set the Contour Properties 
To set the properties of the Contour View, 

18. Do a right mouse click anywhere on the contour plot and then select 
Properties. 

19. Click the General tab and set or change the properties for the Contour plot. 
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Style 
Select how you want the plot to appear, Grayscale or Color.  

Colors 
Range: Use this to select how the coloration of the plot is to be displayed. When 
Light & Dark Range is selected, alternating light and dark bands are used. 
When Full Spectrum is selected, then a continuous color spectrum is used. 

Background: Select the color to be used for the background of the plot. 

Display 
This specifies the relative quality of the displayed contour plot. Less Display 
Detail will result in faster rendering of the plot. 

Print Quality 
This specifies the relative quality of the printed contour plot. Coarse Print 
Quality will result in faster printing. 

Cursors 
The values in these boxes reflect the current contour cursor positions. When 
you change the values, the cursors on the plot will be changed when you exit 
the dialog or when you click the Apply button. 
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Time 
This specifies the time position (X Value) of the cursor. When a value is 
entered, the X cursor is updated to the new position upon exiting the dialog. 

Wavelength 
This specifies the wavelength position (Y Value) of the cursor. When a value is 
entered, the Y cursor is updated to the new position upon exiting the dialog. 

Bandwidth 
This specifies the wavelength band that will be averaged when a chromatogram 
is extracted from the contour plot. The extracted chromatogram is an average 
of the absorbances at each wavelength in the wavelength band. The wavelength 
band is equal to the selected wavelength (see above) +/- one half of the 
bandwidth. 

Set up the Contour Axis 
To set or change the Axis Setup of the Contour Plot, 

1. Do a right mouse click anywhere on the contour plot and then select 
Properties. 

2. Click the Axis Setup tab and set or change the axis properties for the 
Contour plot. 

If the Autoscale box is selected, the software will automatically set the axis parameter. 
If you want to enter the parameter manually, clear the Autoscale box, then enter the 
range values, or click Get Limits to bring in the limits from the current view. 
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Time 
Click Autoscale if you want to have the software automatically scale the time 
axis to the maximum values. To enter a manual range, de-select the autoscale 
box, and add your own limits, or click Get Limits to enter the limits displayed 
on the current contour graph. 

Wavelength 
Click Autoscale if you want to have the software automatically scale the 
wavelength axis to the maximum values. To enter a manual range, de-select the 
autoscale box, and add your own limits, or click Get Limits to enter the limits 
displayed on the current contour graph. 

Absorbance 
Click Autoscale if you want to have the software automatically scale the 
absorbance axis to the maximum values. To enter a manual range, de-select the 
autoscale box, and add your own limits, or click Get Limits to enter the limits 
displayed on the current contour graph. 

Labels 
You can customize the labeling of the contour plot using the parameters in this 
area. You can select font, size, color and style using the selections provided. 
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About the Mixed View 
This view displays the contour, chromatogram and spectrum views along with the 
fourth pane displaying similarity, purity and peak profile.  

 

To zoom in on a portion of either the contour plot, chromatogram or spectrum, hold the 
left mouse button down, move the mouse over the plot until the area of interest is 
highlighted and release the mouse button.  

To quickly move to the previous level of zoom, double-click on the plot. 

To Unzoom to the full plot after multiple zooming operations, use Ctrl+Z, or use Shift + 
double-click in the window, or click the right-mouse button anywhere in the window 
and select Full Unzoom from the pop-up menu. 

Note:  You can synchronize the axis and zoom limits with the other two plots using the 
Synchronize button on the PDA toolbar. When the contour plot is zoomed, the time 
range of the chromatogram and the wavelength range of the spectrum plot are 
automatically adjusted to the same range as the contour. When synchronized zooming 
has been performed, the x axis plot limits for the chromatogram and spectrum plot are 
changed. To unzoom these plots to the limits of the data, you must select Full Unzoom 
from the contour plot context menu. 

Mixed View Options Button 
 
This button presents options that enable you to toggle the view for the lower right pane 
of the mixed view: 

• Show 3D Plot  

• Show Peak Similarity and Threshold Plot  

• Show Peak Purity Plot 

• Show Spectrum Similarity Table 
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Mixed View Actions Button 
 
This button presents the following actions: 

Search Library� 
Opens the Spectral Library Search window. 

Overlay Spectra� 
Allows you to select a spectrum to overlay in the Spectrum view pane. 

Select Peak for Similarity/Purity Display� 
Enables you to select a peak for display in the Purity view pane. 

Add to Multi-Chromatogram Table� 
Enables you to select a chromatogram to add to the Multi-Chromatogram table 
in the PDA options. 

Add Spectrum to Spectral Library 
Selecting this menu item allows you to create a new library entry from the 
spectrum currently displayed in the spectrum pane. The spectrum will be 
added to the currently open library (opened by selecting File > Spectrum 
Library > Open). A name of the form "Spectrum at time xx.xx� will be used as 
the Compound Name for the new library entry. 

About Mixed View w/ 3D 
Select Mixed View w/ 3D from the PDA Views menu to display the contour, 
chromatogram and spectrum views along with a fourth pane containing a three 
dimensional plot of PDA data. 

About Chromatogram View 
The Chromatogram View (also called the Working Chromatogram) may be used alone 
or as part of the Mixed View or Mixed View with 3D displays.   

To generate a working chromatogram from the Contour plot, click and drag the Y-Axis 
arrow to the wavelength of the desired chromatogram.   

To generate a working chromatogram from the Spectrum plot, click and drag the X-Axis 
arrow to the wavelength of the desired chromatogram. 

To add a chromatogram from the Contour or Spectrum plot, click and drag the arrow 
as described above to select the wavelength, and then select Actions followed by Add 
to multi-chromatogram table and then click Add followed by Close. 

The following operations can be performed using the working chromatogram:  

To select a peak for the Similarity/Purity display, hold down the CTRL key and click 
the mouse on the apex of the desired peak.  This function requires that the 
chromatogram has been analyzed first by clicking the Analyze button or selecting 
Analyze from the Analysis menu.  

Right-click within the chromatogram window to display the pop-up menu. This menu 
contains the same options as the basic chromatogram window for all detector types, 
and in addition enables you to overlay chromatograms from different wavelengths and 
change the Gallery view. 
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About the Max Plot 
To view a Max Plot 

1. From the Channel Selection box on the toolbar, click the arrow and then 
select Spectrum Max Plot. 

A Max Plot is a chromatogram with each point plotted at its maximum absorbance. This 
plot gives an indication of the appearance of the chromatogram when the wavelengths 
are optimized for each peak. This plot is useful in selecting an appropriate Analysis 
Channel for each peak.  Note:  The Max Plot is not an analysis channel and is not used 
to analyze chromatographic data.   

 

About the Multi-Chromatogram View 
This view displays multiple chromatographic plots of absorbance versus time, each at a 
different wavelength. This displays all of the chromatograms that were specified in the 
Multi-Chromatogram tab of the PDA Options. 

Click Overlay on the PDA Toolbar to toggle between separate chromatograms and 
chromatograms overlaid on a single axis. 

Right-click within the window to display the data system menu for chromatogram 
window options. 
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About the Spectrum View 
This view displays the spectrum associated with a time on the chromatogram.   

To change the displayed spectrum,  

1. From the View menu, select PDA View and then choose Mixed View, or 
select Views from the PDA Toolbar, and then select Mixed View. 

2. Drag the X-Axis arrow on the Contour plot to a time where the desired 
spectrum is displayed in the Spectrum pane. 

To change the working chromatogram,  

1. From the Mixed View click and drag the arrow in the Spectrum pane to 
the desired wavelength.  The chromatogram associated with this 
wavelength will be displayed in the Chromatogram pane.  

 

Change the Spectrum Properties 

Do a right mouse click in the Spectrum pane, and then select Properties to 
access the standard data system trace properties dialog. This enables you to 
add another trace to the view, or change scaling. It also allows you to 
selectively remove overlaid traces from the view. 

Spectrum Background Correction 

A background correction can be performed if the current spectrum has been 
extracted from an integrated peak of the working chromatogram.  

To perform a spectrum background correction, 

1. Do a right mouse click in the Spectrum window and then select Operations 
followed by Background Correction.   

2. Click the spectrum on which you wish to perform the calculation.  A 
background correction for the displayed spectrum will be performed based 
on the working chromatogram.  The background-corrected spectrum is then 
displayed along with the original spectrum. 

Refer to Background Correction in the PDA Analysis and Calculations 
section for details on how this calculation is performed. 
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Notes: 

Background Correction may only be performed once on a spectrum. If a second 
background correction is attempted on an already corrected spectrum, a message box 
is displayed and the operation ignored. 

If the current spectrum has not been extracted from an integrated peak of the working 
chromatogram, selecting this menu item will have no effect on the spectrum. 

Background subtraction must always be the first operation performed on a spectrum. If 
a background correction is attempted on a spectrum after another operation has 
already been performed (including operation specified in the Spectrum tab of PDA 
Options), a message box is displayed and the background correction request ignored. 

Interpolate Spectrum 
A spectrum interpolation can be performed if the current spectrum has been 
extracted from an integrated peak of the working chromatogram.  

To perform a spectrum background correction, 

1. Do a right mouse click in the Spectrum window and then select Operations 
followed by Interpolate.   

2. Click the spectrum on which you wish to perform the calculation.  A 10:1 
interpolation will be performed on the spectrum. The new interpolated 
spectrum is then displayed along with the original spectrum. 

Refer to Spectrum Interpolation in the PDA Analysis and Calculations 
section for details on how this calculation is performed. 

Export a Spectrum 
To export a spectrum,  

1. In the Spectrum pane, do a right mouse click.  Select Utilities followed by 
Export.  A check-mark will appear next to the Export command. 

2. Click on the spectrum to be exported as an ASCII file. 

3. The Export Spectrum As dialog box will appear.  Browse to the folder 
where you want to save the exported spectrum and then type a name for 
the file in File Name and then click Save. 

Overlay Spectra 
To overlay more than one spectra in the Spectrum pane, 

1. Click Actions from the PDA toolbar, followed by Overlay Spectra... 

2. In the dialog box presented, enter a time for which you want the spectrum 
displayed and then click Overlay, or drag the cursor on the Contour or 
Chromatogram View to the time for which you want the spectrum 
displayed. 

To remove the spectra you have added to the view,  

1. Do a right mouse click in the Spectrum pane, and then select Clear 
overlays.  

You can also clear selected spectra using the Trace Setup dialog accessed by doing a 
right mouse click in the view and then selecting Properties. 
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About the Peak Purity Plot 
 
To show the Peak Purity Plot in the 4th pane of the Mixed View 

1. From the View menu select PDA View followed by Mixed View. 

2. Click Options followed by Show Peak Purity Plot. 

3. Click the Action button, and choose Select Peak for Purity/Similarity 
Display to select a peak for purity display. 

The Total Peak Purity view displays the purity profile for a chromatogram extracted 
from the 3D data.  The view displays purity information for the Max Plot chromatogram 
that is displayed in the Chromatogram pane of the Mixed View.  The pane will be blank 
until the data has been analyzed, and a peak has been selected for the purity 
calculation.   

 

 

Purity View Properties 
To set up the properties for the Purity View, do a right mouse click in the Purity View, 
and select Properties. 
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By default, the Similarity View will use the current method settings from the Purity tab 
of PDA Options.  To override the method settings, click the Override method settings 
box, then enter the values you wish to use. 

Wavelength range 
Specify the wavelength range over which the purity calculations will be 
performed, for example, from 200nm to 400nm. 

Wavelength Step 
Specify the wavelength spacing (in nm) to be used when purity calculations are 
performed. 

Purity threshold 
The comparison of two spectra gives a Similarity Index (SI), the closer to 1.00 
number is the more similar the spectra are.  The purity threshold is used to 
eliminate spectra that do not match.  If the SI is greater than the purity 
threshold, the spectra will be considered pure.  In general, a spectra with an SI 
greater than 0.9900 would have a high probability of being the same as the apex 
spectra.  A SI greater than 0.9000 but less than 0.9900 shows some similarity 
but would need to be evaluated with care and caution.  SI less then 0.9000 
should be considered non-similar.  

Absorbance threshold 
This value represents the percentage of peak height that spectra will included 
in purity calculation.  Spectra in sections of the peak that do not exceed this 
threshold will not be included in the purity calculation.  This provides a 
method of eliminating spectra where the concentration of the compound is so 
low that the solvent spectrum interferes. 

Background compensation 
Checking this box will cause spectra to be corrected for background using the 
peak baseline prior to being used in the calculation of purity. 

Select Peak for Purity Similarity Display 
To select the reference spectrum for the purity calculation,  

PDA Analysis  20 



PDA Control Option 

1. Make sure the data has been analyzed. (If you are not sure, click the 
analyze button on the toolbar.)   

2. Click Actions followed by Select Peak for Purity/Similarity Display.   

3. Select a peak by holding down the CTRL button and then clicking on a peak 
from the Chromatogram or Contour pane.  The retention time of the 
reference spectrum is displayed along with a value indicating peak purity. 

4. Continue to select or change the peak.  When you are finished, click Close. 

 

 
 

Similarity View Properties 
To set up the properties for the Similarity View,  

1. In the Peak Similarity and Threshold Plot, do a right mouse click, and 
then select Properties. 

 

 
By default, the Similarity View will use the current method settings.  To override the 
method settings, click the Override method settings box, then enter the values you wish 
to use. 

Wavelength range 
Specify the wavelength range over which the purity calculations will be 
performed, for example, from 200nm to 400nm. 
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Wavelength Step 
Specify the wavelength spacing (in nm) to be used when purity calculations are 
performed. 

Purity threshold 
The comparison of two spectra gives a Similarity Index (SI), the closer to 1.00 
number is the more similar the spectra are.  The purity threshold is used to 
eliminate spectra that do not match.  If the SI is greater than the purity 
threshold, the spectra will be considered pure.  In general, a spectra with an SI 
greater than 0.9900 would have a high probability of being the same as the apex 
spectra.  A SI greater than 0.9000 but less than 0.9900 shows some similarity 
but would need to be evaluated with care and caution.  SI less then 0.9000 
should be considered non-similar.  

Absorbance threshold 
This value represents the percentage of peak height that spectra will included 
in purity calculation.  Spectra in sections of the peak that do not exceed this 
threshold will not be included in the purity calculation.  This provides a 
method of eliminating spectra where the concentration of the compound is so 
low that the solvent spectrum interferes. 

Background compensation 
Checking this box will cause spectra to be corrected for background using the 
peak baseline prior to being used in the calculation of purity. 

Select Peak for Purity Similarity Display 
To select the reference spectrum for the purity calculation,  

1. Make sure the data has been analyzed. (If you are not sure, click the 
analyze button on the toolbar.)   

2. Click Actions followed by Select Peak for Purity/Similarity Display.   

3. Select a peak by holding down the CTRL button and then clicking on a peak 
from the Chromatogram or Contour pane.  The retention time of the 
reference spectrum is displayed along with a value indicating peak purity. 

4. Continue to select or change the peak.  When you are finished, click Close. 

 

 

 

About the Ratio View 
To show the Ratio Plot 

1. From the View menu select PDA View followed by Ratio Plot. 

PDA Analysis  22 



PDA Control Option 

The Ratio view displays two PDA wavelength channels and the ratio of those two 
channels. These may be viewed during real-time acquisition as well as during post-run 
analysis. The flat tops on the ratio peaks are a preliminary indication of peak purity. 
The ratio wavelengths and parameters are set in the Ratio tab of PDA Options. 

The Y-axis of the ratio chromatogram is auto-scaled to 1.  

 

Right-click within the window to display the pop-up context menu. The context menu is 
the same as for a standard chromatogram graph window. 

 

PDA Utilities 
To access the Utilities menu,  

1. Do a right mouse click from any PDA View and then select Utilities. 

The Utilities menu allows displayed spectra to be printed, copied, saved or exported. 
 Some or all of the following options will be presented. 

Print 
Select Print to automatically print the currently displayed spectra.  

Copy to Clipboard  
Select Copy to Clipboard to copy the displayed spectra to the Clipboard. The 
contents of the Clipboard may then be pasted into other software. 

Save trace  
Select Save trace to save the spectrum to a file with an .spc extension for later 
inclusion in a library or report. 

Export 
Select Export to enable export of the item in the method. 
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About the Spectrum Similarity Table 
The Spectrum Similarity table is displayed in the fourth pane of the PDA Mixed View 
when the Options Mode is set to Show Spectrum Similarity Table. 

To view the Spectrum Similarity Table 

1. In the Mixed View, click Options. 

2. Select Show Spectrum Similarity Table. 

Spectra are automatically added to and deleted from this table whenever a spectrum is 
added to and deleted from the Spectrum pane of the Mixed View. 

 

Spectrum Name 
This column displays identifications for each of the spectra added to the table. 
For spectra extracted from the 3D data, the identification includes the time. 
For spectra extracted from a chromatogram based on a peak name, the 
identification includes the peak name. For spectra loaded from a file, the 
identification includes the retention time. 

A check mark next to the colored line for a spectrum indicates that the 
spectrum will serve as the Reference Spectrum for the similarity calculation. 

Spectra may be added to the table in the Mixed View by selecting the Add to 
Similarity Table from the Actions button menu. 

Similarity 
This column displays the similarity of the spectrum on that row relative to the 
Reference Spectrum. The Reference Spectrum is determined by double-clicking 
on a row of the table or by highlighting a row and pressing the �Set Reference� 
button. 

Until a reference spectrum has been selected the similarity for all spectra in the 
table will be zero. 

Refer to the PDA Analysis and Calculations section for details on how this 
calculation is performed. 

Source 
This column displays the source of the spectrum. (Current Data) refers to 
working spectra extracted form the current 3D data. When spectra come form a 
stored data file, this column will display the source filename. 
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Set Reference 
Click this button will designate the spectrum in the currently highlighted row 
of the table as the new reference spectrum. The similarities for all of the rows 
will be recalculated based on the new reference spectrum. 

Print 
Click this button will output a simple text report representation of the table to 
the default printer. 

Properties 
Click this button will display a dialog with parameters related to the 
calculation of similarity. 

Set the Similarity Table Properties 
To set the properties for the Similarity Table 

1. From the Spectrum Similarity Table, click Properties to display the table 
properties dialog box. 

2. Enter the wavelength range and data point spacing (in nm) for similarity 
calculations. 

 

Note:  During analysis, it is possible that a portion of this wavelength range will be outside the 
range of the acquired data. In that case, the wavelength range will be truncated to the limits of 
the acquired data.  

Extract a Chromatogram 
To generate a chromatogram view (extract a working chromatogram) from contour 
view of Mixed View or Mixed View w/ 3D: 

1. From the View menu, select PDA View followed by Mixed View, or click 
Views from the PDA Toolbar and then select Mixed View.  This will 
display the Contour Map, Chromatogram, and Spectrum. 

2. Move the cursor to the triangle-shaped handle located on the left- hand 
wavelength axis of the Contour Map and press the left mouse button. 

3. Drag the cursor up or down to the desired wavelength and release the 
mouse button. 

4. The chromatogram associated with the specified wavelength will be 
displayed in the Chromatogram View.  

4 About PDA Method Options 
The PDA Options enable you to set up a variety of analysis options for use with a 
configured photo diode array detector.  To access the PDA Options for your method, 

5. From the Method menu, select PDA Options... 
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6. Click the desired tab to set the parameters for data analysis.   

Tab Used for 

Library Enabling spectral libraries and specifying search 
parameters. 

Purity Entering parameters for purity calculations. 

Spectrum Defining filtering and per-peak spectrum 
parameters 

Multi-chromatogram Enabling multi-wavelength chromatograms 

Ratio Setting up ratio plots 
 

 

Set Library Options 
To set the PDA Library options, 

1. From the Method menu, select PDA Options and then click the Library 
tab. 

Using this tab, you can enter library parameters for spectral library searches that will 
be saved as part of your method. When you do a spectral library search "using method 
parameters", these parameters will be used. 

 

 

Library/Enabled 
Enter the spectral library to be searched or select from available libraries by 
clicking the Library field followed by clicking the file button. You can select 
more than one library. To enable the library for searching, click the Enabled 
box. If this list is empty, or no library is enabled, no hits will be returned when 
a search is performed. 
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Search parameters 
Enter the parameters to use for the search. 

Wavelength range 
Enter the wavelength range to search 

Wavelength step 
Enter a step number for the search. Larger numbers will make the search 
faster, but if you use too large of a step, spectral details may not be picked up. 

Max hits 
Specify the number of hits that will be reported in the results of a library 
search. Note that this works in conjunction with the Similarity Threshold 
parameter to limit the number of hits reported. 

Similarity threshold 
Enter a number for threshold of similarity. The library search results will only 
display matches whose similarity to the unknown exceeds this value. 

Pre-filters 
The options in this group allow you to specify search pre-filters that will be 
performed on library spectra prior to the test for similarity. All pre-filters are 
optional. 

Retention time range 
When values are entered in these fields, PDA limits its search to library spectra 
obtained from peaks whose apex are within the specified retention time range. 
This pre-filter is optional and may be left blank. 

Lambda max  
When one or more of these values is specified, library search will be restricted 
to those library entries containing lambda max value(s) within 5nm of all of the 
specified values. Entries without matching lambda max value(s) are 
automatically excluded from the search (no similarity calculation is made). 
Entering values for lambda max is optional. 

Compound name filter 
If you are searching only for spectra that contain a certain name, enter the 
name here. Only spectra containing that name will be searched. 

PDA Options Purity 
To set the PDA Purity options, 

1. From the Method menu, select PDA Options and then click the Purity tab. 

The Purity tab is used to set the parameters necessary to perform on-demand peak 
purity calculations and peak purity calculations that occur as part of analysis.  
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Purity Calculations 
From/To � wavelength range 
Specify the wavelength range over which the purity calculations will be 
performed, for example, from 200nm to 400nm. 

Step 
Specify the wavelength spacing (in nm) to be used when purity calculations are 
performed. 

Purity threshold 
The comparison of two spectra gives a Similarity Index (SI), the closer to 1.00 
number is the more similar the spectra are.  The purity threshold is used to 
eliminate spectra that do not match.  If the SI is greater than the purity 
threshold, the spectra will be considered pure.  In general, a spectra with an SI 
greater than 0.9900 would have a high probability of being the same as the apex 
spectra.  A SI greater than 0.9000 but less than 0.9900 shows some similarity 
but would need to be evaluated with care and caution.  SI less than 0.9000 
should be considered dissimilar.  

Absorbance threshold 
This value represents the percentage of peak height that spectra will included 
in purity calculation. Spectra in sections of the peak that do not exceed this 
threshold will not be included in the purity calculation. This provides a method 
of eliminating spectra where the concentration of the compound is so low that 
the solvent spectrum interferes. 

Background compensation 
Checking this box will cause spectra to be corrected for background using the 
peak baseline prior to being used in the calculation of purity. 
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Per-peak spectrum calculations 
Checking any of these boxes indicates that the indicated value will be 
calculated on a per-peak basis during analysis. The result of this calculation 
will then be available in reports and as chromatogram annotations.  

Unchecking values that are not of interest will speed up analysis. If a box is unchecked 
and the field appears in a run report, it will be reported as zero 

Total Purity 
Checking this box will cause total peak purity to be calculated on a per-peak 
basis during analysis. The result of this calculation will then be available in 
reports and as chromatogram annotations. If this box is unchecked and a 
report contains the field, a zero will be reported. 

3 Point Purity 
Checking this box will cause 3-point peak purity to be calculated on a per-peak 
basis during analysis. The result of this calculation will then be available in 
reports and as chromatogram annotations. If this box is unchecked and a 
report contains the field, a zero will be reported. 

PDA Options Spectrum 
To set the PDA Spectrum options, 

1. From the Method menu, select PDA Options and then click the Spectrum 
tab. 

The Spectrum tab is used to specify the types of filtering and processing to be 
performed on spectra that are extracted from the 3D data during analysis as well as to 
spectra displayed in the PDA Spectrum View.  

Note:  The processing specified on this page is performed prior to any use of the spectra in 
the software, including display, searching and reporting. 
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Spectral filtering 
In this area you designate how spectral filtering (if any) will be performed. 

Filtering type 
Choose the type of filtering for the spectral plot. Choices are None, Smooth, 1st 
Derivative, and 2nd Derivative. Selecting one of these smoothing algorithms can 
remove noise from the spectrum. 

Background correction 
If this box is checked, then, prior to display, a correction for spectral 
background is made, as follows:  

1. The spectra from the baseline start and baseline stop times for the peak are 
extracted from the data.  

2. For each spectrum in the peak, a corresponding background spectrum is 
generated by linear interpolation between the baseline start and baseline stop 
spectra.  

3. This background spectrum is subtracted from the original spectrum.  

Note:   The baseline start and stop times that are used in calculating background 
compensation are based on the detected peaks for the channel currently selected. 

Interpolate spectra 
Select this check box to automatically perform 10:1 interpolation of spectra 
displayed in the spectrum window using a cubic spline curve fit. This 
interpolation is performed after the applying any spectral filtering option (1st 
derivative, 2nd derivative or smooth) to the display spectrum. 

Note: Interpolated spectra may not be stored or added to a library. 

The peak spectrum is defined as 
This specifies how the spectra extracted from the 3D data are averaged before 
being exported or used in the Spectrum Report.  

Spectrum Averaging is the calculation of a spectrum whose absorbance values 
are the average of the absorbances.  

The peak apex spectrum 
When this is selected, the spectrum at the apex of the peak will be used, 
without averaging. 

The average of upslope/apex/downslope spectra 
When this is selected, three spectra (the spectra at the upslope inflection point, 
the apex and the downslope inflection point) are averaged.   

The average of every n spectra across the peak 
When this is selected, enter a value for n. Every nth spectrum from the peak is 
extracted, beginning at the start of the peak and continuing to the end of the 
peak. These extracted spectra are averaged and become the spectrum that is 
used.  

PDA Analysis  30 



PDA Control Option 

Per-peak spectrum calculations 
Checking any of these boxes indicates that the indicated value will be 
calculated on a per-peak basis during analysis. The result of this calculation 
will then be available in reports and as chromatogram annotations.  

Unchecking values that are not of interest will speed up analysis. If a box is 
unchecked and the field appears in a run report, it will be reported as zero 

Similarity 
Checking this box causes the Peak Apex Similarity to the reference spectrum to 
be calculated on a per-peak basis during analysis. The result of this calculation 
will then be available in reports and as chromatogram annotations. If this box 
is unchecked and a report contains the field, a zero will be reported. 

Peak Apex Similarity applies only to named peaks and its use requires that a 
reference spectrum be included in the peak table.  

Upslope Similarity 
Checking this box causes upslope similarity to be calculated on a per-peak 
basis during analysis. Upslope similarity compares the peak apex spectrum to 
the spectrum at the peak inflection point on the upslope side (to the left of the 
apex). The result of this calculation will then be available in reports and as 
chromatogram annotations. If this box is unchecked and a report contains the 
field, a zero will be reported. 

Downslope Similarity 
Checking this box causes downslope similarity to be calculated on a per-peak 
basis during analysis. Downslope similarity compares the peak apex spectrum 
to the spectrum at the peak inflection point on the downslope side (to the right 
of the apex). The result of this calculation will then be available in reports and 
as chromatogram annotations. If this box is unchecked and a report contains 
the field, a zero will be reported. 

Lambda Max 
Checking this box indicates causes the lambda max (wavelength at which the 
highest absorbance occurs) to be computed for each peak of each multi-
chromatogram extracted from the 3D data during analysis. The result of this 
calculation will then be available in reports and as chromatogram annotations. 
If this box is unchecked and a report contains the field, a zero will be reported. 

Lambda Max Calculation Range 
This allows the user to restrict the wavelength range over which the Spectrum 
Max Plot will be calculated. Default is the detector acquisition range. 

Set Multi-Chromatogram Options 
To set the PDA Multi-Chromatogram options, 

1. From the Method menu, select PDA Options and then click the Multi-
Chromatogram tab. 

The Multi-Chromatogram tab is used to specify data channels within the 3D data for 
integration and quantitation. It allows you to select wavelengths to display on the 
Multi-Chromatogram plot. When you select an Enabled box, enter a wavelength and 
bandwidth to be used for one plot. After you have set up several wavelengths, you can 
disable them temporarily by clicking the Enabled box such that the check mark is not 
displayed. The Multi-Chromatogram display is selected from the View Gallery. The 
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Multi-Chromatogram view is not functional unless one or more valid wavelengths are 
enabled in the Multi-Chromatogram Definition tab. 

 

 

Enabled 
To enable a wavelength, click the checkbox. To disable a wavelength, click the 
checkbox again to remove the checkmark. Only enabled wavelengths will 
appear in the multi-chromatogram view. 

Wavelength 
Enter the wavelength you want to view. 

Bandwidth 
Specify the nm range to be averaged in generating the analog signal for each 
channel. 

The multi-chromatogram data is calculate by averaging the data points of 
chromatograms across the wavelength range of "wavelength - 1/2*bandwidth" 
to "wavelength + 1/2*bandwidth". 

For example, given a wavelength of 600 nm and a bandwidth of 4 nm, for each 
sample time, the data points from the chromatograms at 598, 599, 600, 601 and 
602 nm are added, and the sum divided by 5. 

If, in the example above, the detector's range is 190 - 600 nm (inclusive), the 
software only averages the points across chromatograms at 598, 599 and 600 
nm (dividing by 3). The range would not be exceeded. 

Subtract baseline chromatogram 
Click this to enable baseline subtraction of a designated chromatogram to be 
extracted from the 3D data. 
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Wavelength 
Enter the wavelength at which you wish to extract a chromatogram to be used 
for baseline subtraction. 

Bandwidth 
Specify a bandwidth range to be averaged in generating the extracted 
chromatogram. 

 

PDA Options Ratio 
To set the PDA Ratio options, 

1. From the Method menu, select PDA Options and then click the Ratio tab. 

The Ratio tab is used to set the displays of the Ratio Plot View. The Ratio View displays 
two PDA wavelength channels and the ratio of those two channels. These may be 
viewed during real-time acquisition as well as during post-run analysis. The flat tops on 
the ratio peaks are a preliminary indication of peak purity.  

 

 

Ratio plot 
These controls specify the wavelength of the ratio multi-chromatogram 
channels. The extracted chromatograms will be centered about the specified 
wavelength. 

Channel 1, Channel 2 
Wavelength 
Enter the wavelength of the chromatogram channel. 

Bandwidth  
Enter the nm range to be averaged in generating the chromatogram channel. 

Threshold 
Enter the ratio threshold. The threshold is the minimum absorbance value 
required in the chromatograms of both channels for calculation of the ratio. It 
is a method of eliminating ratio calculation at minor absorbance values, such as 
those that occur with noise. If the threshold value is not met, the ratio plot will 
be zero. 
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5 Spectral Library Search 

Define a Spectral Library 
In order to define a library, you must have the spectra to be added saved on disk as 
spectra files (.spc) or you can create a library from the spectra obtained during the 
current run. To define a spectral library 

1. From the File menu, select Spectral Library followed by New to create a 
new spectral library.  Select Open to browse for and open an existing 
library to modify.   

2. Click Spectrum Data Source and select Current Data, Spectrum File or 
Named Peak.   

If you select Current Data, a dialog box will appear where you enter the retention 
time for the spectra to be added to the library.   

If you select Spectrum File, browse to the spectrum file to be added to the library 
and then click OK.   

If you select Named Peak, chose a peak whose spectrum is to be added to the 
spectral library from the dialog box presented. (The current chromatogram must be 
Analyzed first in order to use this option.) 

 

Spectrum Data Source  
Click on the arrow in this field to select either Current Data,  Spectrum File, 
or Named Peak to be used to select the spectrum to be added to the library.  

To add a spectrum from a spectrum file, the spectrum must have been 
previously saved as a file with the .spc extension, for example, using the Save 
Trace function accessed by doing a right mouse click  in the Spectrum pane 
followed by Utilities. 

If you chose to enter a spectrum from the current data file, a dialog box will 
appear where you must select the retention time at which you wish to select 
the spectrum. 
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If you chose to enter a spectrum from a named peak, a dialog box will appear 
where you must select the named peak from which the spectrum will be 
extracted. 

Component Name  
Enter the chemical name or description of the spectrum. This field is used for 
display and search pre-filter purposes. 

Lambda Max From ... To  
The wavelength range of the spectrum over which the software will calculate 
the lambda (absorbance) max value is displayed in these columns. 

Retention time  
When the spectrum was extracted from a chromatographic run, the software 
automatically identifies the retention time of the spectrum and enters the value 
in this field. When desired, the value in this field may be edited. This field can 
also be used as a search pre-filter. 

Comment  
Enter any descriptive information desired related to the spectrum. This field is 
used only for display and documentation purposes. 

Library Notes  
This field is used to document relevant information about the library as a 
whole, e.g., documentation about run conditions or general sample information. 

Note:  Fields in existing library entries may be edited by selecting the fields with the cursor. 
Right-click on a row in the library table to display a pop-up menu used to cut, paste, 
copy, and insert and delete lines from the library as necessary. 

Search the Spectral Library 
 
To open Spectral Library Search, 

1. From Mixed View, click Actions followed by Search Library.  

From here you can perform a library search on a spectrum you have selected in the 
contour map, and you can also select a spectrum from the current data or stored 
spectrum file to search. 
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Hits Displayed 
Select the number of hits you wish to display. Hits will be displayed in order of 
similarity. 

Search 
Select Method if you want to use the parameters from the current method for 
your search. Select Quick if you want to enter or change the parameters 
yourself before the search. 

Display Params 
Click this button if you want to display the parameters. It toggles between 
display and no display.  If you always use the method parameters, you may not 
wish to display them when you search. 

Search Now 
When you click this button, a library search will be performed on the selected 
spectra using the parameters, and the number of hits requested will be 
displayed. 

Search Spectrum 
Click the arrow to select a new spectrum to search on. You can choose from the 
current data, or from a stored spectrum file. The current spectra source will be 
displayed. 

Params 

This tab contains search parameters. If you have elected to use the Method 
search parameters, the parameters displayed will be those in your current 
method in the Library tab of the PDA Options. If you have elected to do a 
Quick search, the parameters will be default parameters. 

Wavelength Range 
These specify the wavelength range over which the library search will be 
performed. 
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Wavelength Step 
This specifies the data point spacing to be used when a library search is 
performed. 

Max Hits 
This specifies the number of hits that will be reported in the results of a library 
search. Note that this works in conjunction with the Similarity Threshold 
parameter to limit the number of hits reported. 

Similarity Threshold 
Specifying a value for this control will cause the library search results to only 
display matches whose similarity to the unknown exceeds this value. Note that 
this control works in conjunction with the Max Hits parameter to limit the 
number of hits reported. 

Library 
Displays the library from the method, or for Quick enables you to select a 
library to be used. 

Pre-Filters 

When Quick is selected as the Search Mode, the items on this tab allow the 
user to specify search pre-filters that will be performed on library spectra prior 
to the test for similarity. All pre-filters are optional. If Method is selected as the 
Search Mode, the items on this tab are read-only and reflect the parameters 
values on the Library tab of PDA Options. 

Retention Time Range 
When a Retention Time Range is specified, library search will be restricted to 
those library entries whose retention time is within the specified range. Entries 
outside this range are automatically excluded from the search (no similarity 
calculation is made). Entering a value for this is optional. 

Lambda Max 
When one or more of these values is specified, library search will be restricted 
to those library entries containing a lambda max within 5 nm of one of the 
specified values. Entries without a matching lambda max are automatically 
excluded from the search (no similarity calculation is made). Entering values 
for this is optional. 

Compound Name Filter 
When a Compound Name Filter is specified, library search will be restricted to 
those library entries whose name contains the specified string as a case-
insensitive sub-string. Entries without a matching sub-string are automatically 
excluded from the search (no similarity calculation is made). Entering a value 
for this is optional. 

Choose a Spectrum to Search 
 
To chose a spectrum to use for the library search, 

1. From the Mixed View, click Actions and then select Search Library. 

2. Click Search Spectrum. 

3. Select Current Data, Spectrum File, or Named Peak. 
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4. Enter the Retention Time, Spectrum File, or Named Peak to be used for 
the search. 

 

 

6 How to Perform a Manual Library Search 
1. In the Contour pane of the Mixed View window, drag the vertical cursor to the 

apex of the peak of interest to display the corresponding spectrum in the 
spectrum pane. 

2. Click on Actions and then click Search library� to open the Spectral Library 
Search dialog box.  On the toolbar Search selection, click either Method to use 
the library parameters from the method, or Quick to enable you to modify the 
search parameters. Before you do the search, make sure you have either 
selected a library in your method, or have opened a library to do a quick 
search. 

3. Click Search Now to display the Library Search Results window, showing the 
three closest matches in the specified library. When appropriate, click on the 
>> or << button to display additional matches. 

7 How to Collect Spectra for a Library 
 

5. Perform an acquisition using a sample with known components or 
standards to be placed in the library. 

6. Perform an analysis using the appropriate integration parameters. (Ideally, 
Spectral Background Correction would be checked in the Spectrum tab of 
PDA Options.) 

7. Using the Contour plot in the Mixed View window, drag the vertical cursor 
to the apex of a peak to display the corresponding spectrum in the 
spectrum view. See also About Spectra Extracted from the Contour View. 

8. Right-click within the spectrum view to display the Spectrum pop-up menu, 
select Utilities followed by Save Trace.  A check-mark will appear next to 
Save Trace.  Click on the spectrum you wish to save.   Browse to the 
location where you want to save the spectrum file, and enter a file name in 
the dialog box and then click Save. Repeat this procedure for each 
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spectrum to be added to the library. Files are saved automatically with the 
.spc extension. 

Note: To add the 1st or 2nd Derivative of a spectrum to the library, select the appropriate filter in the 
Spectrum tab of PDA Options and repeat steps 3 and 4. 

Reports and Peak Table 

8 About PDA Report Items 
 
When the PDA option is enabled, the following report items will be available to insert 
into a custom report: Library Search Report, Library Definition Report, Purity Report, 
and Spectrum Report. 

Custom Report Graph Items for PDA 
 
The Insert Graph menu has the following additional items available when the PDA 
Option is enabled: 3D Data Graph, and Contour Graph. 

3D Data Graph 
The 3D View provides a three-dimensional view of absorbance versus time and 
wavelength. Wavelengths of appreciable absorbance and interferences, which may be 
invisible in a single wavelength plot, are easy to locate with the 3D View. Select this 
function to automatically enter the 3D map into the report. Click the right-mouse 
button within the 3D map and select Properties to display the 3D Properties dialog box 
and enter appropriate changes 

The 3D map can be elevated and rotated around its axis for display from any angle. 
These functions work the same as in the 3D view window.  

Insert Contour Graph 
A data file containing PDA data may include a Contour Plot in a custom report. The 
contour view (also referred to as Isoabsorbance plot) provides an aerial view of the 
absorbance of the sample at each wavelength vs. time. The contour view supplies quick 
and easy�to-assimilate information about those wavelengths at which the sample 
exhibits appreciable absorbance.  

Changing parameters for the contour graph in a custom report works exactly as in the 
Contour view.  

9 Custom Report PDA Parameters 
 
A variety of PDA information can be placed in a custom report. These items are 
inserted in the report by placing the cursor at the location where you want to insert the 
item, then do a right mouse click to access the custom report menus. 

Create a Library Search Report 
 
To create a Library Search Report, or add a Library Search Report to your custom 
report, 
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1. Click Edit Custom Report to open the custom report. 

2. On the custom report, do a right mouse click and select Insert Report 
followed by Library Search Report.  The Library Search Report template 
will be inserted at the location of the cursor in the custom report. 

To modify the parameters of the report, do a right mouse click in the report table, then 
select Properties.  

 

Search Libraries for 
This specifies what peaks should be searched for the report. When Apex 
Spectra of Peaks is selected, the Specific Spectrum button is disabled. When 
A Specific Spectrum is selected, the other controls of this group are disabled.  

Apex spectra of peaks 
Choose this option to enable search based on the apex of peaks detected by 
criteria you select. 

Detected on 
Select the detection criteria for the peaks to be searched.  Choices include All 
Multi-Chroms, All PDA Traces, Max Spectrum Plot, or the available 
wavelength channels. 

Limit to named peaks only 
This allows the user to restrict the peak selection (made above) to a time range. 
When checked, only peaks within the specified time range will be searched 
When this box is unchecked, the Time Range edit fields are disabled.  

Limit Peaks to time range 
This allows you to restrict the peak selection (made above) to a time range. 
When checked, only peaks within the specified time range will be searched. 
When this box is unchecked, the Time Range edit fields are disabled. 
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A Specific Spectrum  
Select this to specify the spectrum to be searched. When this is selected, click 

the button to select the spectrum source.  The menu contains  the following 
choices: Current Data, Named File, or Spectrum Peak. 

Spectral Display 
The in this group specify the layout of the search results graphs. 

Graph Height 
This specifies the relative height of a search results graph. A value of 100% 
corresponds to a standard sized graph. A larger value may be selected to 
provide more a detailed plot. 

Graph Properties 
Pressing this button displays the graph properties dialog as found on the 
standard Spectrum graph.  

Create a Library Definition Report 
 
To create a Library Definition Report, or add a Library Definition Report to your 
custom report, 

1. Click Edit Custom Report to open the custom report. 

2. On the custom report, do a right mouse click and select Insert Report 
followed by Library Definition Report.  The Library Definition Report 
template will be inserted at the location of the cursor in the custom report. 

To specify parameters for the report, do a right mouse click in the report table, then 
select Properties. The Library Definition Report Properties dialog will appear. 

 

Enter or select the library you wish to include in the report, then click OK. 

Create a Purity Report 
 
To create a Purity Report, or add a Purity Report to your custom report, 

1. Click Edit Custom Report to open the custom report. 

2. On the custom report, do a right mouse click and select Insert Report 
followed by Purity Report.  The Purity Report template will be inserted at 
the location of the cursor in the custom report. 

Selecting this option will insert a Purity Report into your custom report. To specify 
parameters for the report, do a right mouse click in the report table, then select 
Properties.   
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Detected on 
This allows the user to select the channel or channels from which peaks will be 
detected. 

Limit to named peaks only 
This allows the user to restrict the peak selection (made above) to named 
peaks.   

Limit to time range 
This allows the user to restrict the peak selection (made above) to a time range. 
When checked, only peaks within the specified time range will be searched. 
When this box is unchecked, the Time Range edit fields are disabled. 

Graph  
Select the type of curve you want to graph - Purity Curve or 
Similarity/Threshold Curve. 

Height % 
This value will enable you to "zoom" the graph.  A value of 100% will maximize 
the curve to the page. 

Graph Properties... 
Pressing this button displays the graph properties dialog as found on the 
standard graph.  

Create a Spectrum Report 
To create a Spectrum Report, or add a Spectrum  Report to your custom report, 

1. Click Edit Custom Report to open the custom report. 

2. On the custom report, do a right mouse click and select Insert Report 
followed by Spectrum Report.  The Spectrum Report template will be 
inserted at the location of the cursor in the custom report. 

The report will display a table showing spectra extracted from peaks of the 
chromatogram. Based on the selection on the Spectrum tab of PDA Options, the report 
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will contain either the apex spectrum, an average of the upslope, apex and downslope 
spectra, or several averaged spectra.  

To set parameters for this report, do a right mouse click on the table, and then select 
Properties.   

 

Report peak spectra 

Detected on 
This allows the user to select the channel or channels from which peaks will be 
detected. 

Limit to named peaks only 
This allows the user to restrict the peak selection (made above) to a time range. 
When checked, only peaks within the specified time range will be searched 
When this box is unchecked, the Time Range edit fields are disabled.  

Limit Peaks to time range 
This allows the user to restrict the peak selection (made above) to a time range. 
When checked, only peaks within the specified time range will be searched. 
When this box is unchecked, the Time Range edit fields are disabled. 

Time Range 
This allows the user to restrict the peak selection (made above) to a time range. 
When the Limit to time range box is unchecked, these fields are disabled. 

Report information 
Checking any of these indicates that the indicated value will be calculated and 
printed to the right of the graph. Unchecking values that are not of interest will 
speed up analysis. 

Peak Area 
Checking this indicates that the peak area should be printed to the right of the 
spectrum graph. 
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Lambda Max 
Checking this indicates that the three largest lambda max values should be 
printed to the right of the spectrum graph. 

Lambda Min 
Checking this indicates that the three largest lambda min values should be 
printed to the right of the spectrum graph. 

Total Purity 
Checking this indicates that total peak purity should be printed to the right of 
the spectrum graph. 

3 Point Purity 
Checking this indicates that 3 point peak purity should be printed to the right 
of the spectrum graph.  

Similarity 
Checking this indicates that peak apex similarity to the reference spectrum 
should be printed to the right of the spectrum graph. The use of this value 
requires that a reference spectrum be included in the peak table. See the 
section on Analysis and Calculations for details.  

Spectral Display 
The selections in this group specify the content and labeling of the spectrum 
graphs. 

Show Lambda Maxima 
Checking this box will annotate each spectrum graph with the 3 largest lambda 
max absorbance. 

Show Lambda Minima 
Checking this box will annotate each spectrum graph with the 3 largest lambda 
minima absorbance. 

Background Correction 
Checking this will cause each apex spectrum to be corrected for background 
using the chromatographic baseline prior to being used elsewhere in analysis. 
Refer to the PDA Analysis and Calculations section for details on the formula 
used.  

Filtering Type 
This allows the user to specify a mathematical filtering function to be 
performed on all spectra extracted from the 3D data during analysis. Refer to 
the Analysis and Calculations section for details on the formula used for each 
filter. 

Graph Height 
This specifies the relative height of the spectrum graph. A value of 100% 
corresponds to a standard sized graph. A larger value may be selected to 
provide more a detailed plot. 

Graph Properties 
Click this button to display the graph properties dialog as found on the 
standard Spectrum graph.  
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10 Changes to the Peak Table for PDA Option 
 
When using the PDA option, certain columns will be added to the peak table that 
enable you to analyze peaks from the PDA detector. 

Detection 

Select the basis for the identification of the peak. If you choose Ret Time, only 
the retention time will be used for identification of the peak. If you choose Ret 
Time with Spectral Confirm, the Similarity of the peak�s spectrum to that of a 
designated reference spectrum will be used in addition to the retention time as 
the basis of peak identification.  

Spectrum  

If you want Similarity to be used as a basis for peak identification, then click 
on the arrow to the right of this field to specify the stored reference spectrum 
to be used for comparison. During identification, this reference spectrum is 
compared to the peak apex spectrum and a similarity index is computed. A 
peak is considered identified if this calculated similarity index is at least the 
value specified in the Similarity column of the peak table.  

If Similarity is not specified as a basis for peak identification, then this field is 
ignored. 

Similarity  

If Similarity is specified as a basis for peak identification, then this field 
specifies required minimum similarity index for a peak to be considered 
identified. During identification, the reference spectrum (see previous section) 
is compared to the peak apex spectrum and a similarity index is computed. A 
peak is considered identified if the calculated similarity index is at least the 
value in this field. 

If Similarity is not specified as a basis for peak identification, then this field is 
ignored. 

Analysis Channel 

Specify which Diode Array wavelength channel is to be used for analysis of the 
peak. The choices will be those specified in Instrument Setup/DAD.   

11 PDA Analysis and Calculations 
 
This section describes the various types of calculations that are related to PDA data 
and how the data is analyzed. 

General 
In order to maintain accuracy during the application of multiple operations, all 
calculations are performed using double-precision floating-point numbers. 

 

Analysis spectra

Background correction

PDA Analysis  45 



PDA Control Option 

Calculating total purity

Chromatograms extracted from the 3D data

Lambda max/min calculations

Library search calculations

Multi-chromatogram channels

Peak purity calculations

Pre-filters

Ratio chromatogram calculation

Similarity calculations

Spectra extracted from the 3D data

Spectrum derivatives

Spectrum interpolation

Spectrum operations

Spectrum smoothing

Three-point purity calculations

Upslope and downslope spectra

Working chromatogram

Working spectrum

About Chromatograms Extracted from the Contour View 
Two types of chromatograms may be extracted from the 3D data: 

• Multi-Chromatogram Channels: One or more chromatograms defined on the 
Multi-Chromatogram tab. 

• Working Chromatogram: A single chromatogram extracted from the Contour 
plot on the Mixed View display. (This chromatogram is displayed in the 
Chromatogram View) 

To generate a chromatogram view (extract a chromatogram) from contour view of 
Mixed View or Mixed View w/ 3D: 

3. Select PDA Views from the View menu, and then select Mixed View to 
display the Contour Map, Chromatogram, and Spectrum. 

4. Move the cursor to the triangle-shaped handle located on the left- hand 
wavelength axis of the Contour Map and press the left mouse button. 

5. Drag the cursor up or down to the desired wavelength and release the 
mouse button. 

6. The chromatogram associated with the specified wavelength is displayed in 
the Chromatogram View.  

About Multi-Chromatogram Channels 
 
The following apply to multi-chromatogram channels: 
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• In the Channel Selection drop down list, each multi-chromatogram channel 
have a unique identifier that includes the wavelength and bandwidth of the 
channel. 

• Each Multi-Chromatogram Channel have a separate Integration Events Table, 
Manual Integration Table, Export Table and Performance Table associated with 
it. 

• All Multi-Chromatogram Channels share a common peak and group table. 
Within the peak and group tables, any channels may be selected as the analysis 
channel for quantitative information. 

• When an analysis is performed, all multi-chromatogram channels are 
automatically analyzed. 

• Each multi-chromatogram channel is an average of the absorbances monitored 
at each wavelength in the wavelength range. The wavelength range is equal to 
the selected wavelength +/- one half of the bandwidth.  

About the Working Chromatogram 
 
The following apply to the working chromatogram: 

• In the Channel Selection drop down list, a single entry is added that identifies 
the channel as applying to the working chromatogram. 

• This channel has a separate Integration Events Table, Manual Integration 
Table, Export Table and Performance Table associated with it. These are 
separate from the tables of the Multi-Chromatogram Channels (above). 

• When an analysis is performed, the working chromatogram will automatically 
be analyzed. 

• The working chromatogram is an average of the absorbances monitored at each 
wavelength in the wavelength range. The wavelength range is equal to the 
selected wavelength +/- one half of the bandwidth.  

About Spectra Extracted from the Contour View 
 
Two types of spectra may be extracted from the 3D data: 

• Analysis Spectra: One or more spectra automatically extracted from the 3D 
data during analysis and used for peak identification, similarity and/or library 
search.  

• Working Spectrum: A spectrum extracted from the Contour plot on the Mixed 
View display. (This chromatogram is displayed in the Spectrum View) 

To generate a spectrum view (working spectrum) from the contour view of Mixed View 
or Mixed View w/ 3D: 

7. Select PDA Views from the View menu, then select Mixed View to 
display the Contour Map, Chromatogram, and Spectrum. 

8. Move the cursor to the triangle-shaped handle located on the time axis 
of the Contour Map and click the left mouse button. 

9. Drag the cursor to the desired peak and release the mouse button 

10. The spectrum associated with the specified retention time value is 
displayed in the Spectrum View. 
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About Analysis Spectra 
 
The following applies to the analysis spectra: 

• Prior to being used elsewhere, all analysis spectra extracted from the data are 
filtered according to the settings on the Spectrum tab of PDA Options.  

About Working Spectrum 
 
The following apply to the working spectrum: 

• Working spectra extracted from the 3D data are never filtered according to the 
settings on the Spectrum tab of PDA Options.  

• The working Spectrum is not available as a trace in Custom Reports.  

Background Correction 
 
Background Correction may only be performed on a spectrum as a result of the settings 
on the Spectrum tab of PDA Options, the settings on the Purity tab of PDA Options, 
or by setting the properties of the Peak Purity Pane. 

Background subtraction is always the first operation performed on a spectrum. If a 
background correction is attempted on a spectrum after another operation has already 
been performed (including an operation specified in the Spectrum tab of PDA 
Options), a message box is displayed and the background correction request ignored. 

Background subtraction may only be performed once on a spectrum. If a second 
background correction is attempted on a spectrum after the operation has already been 
performed (including the operation specified in the Spectrum tab of PDA Options), a 
message box is displayed and the background correction request ignored. 

A background correction is performed as follows: 

1. The spectra from the baseline start and baseline stop times for the peak are 
extracted from the 3D data. The Max Plot is used to determine the peak that is used.  

2. For each spectrum in the peak, a corresponding background spectrum is generated 
by linear interpolation between the baseline start and baseline stop spectra.  

3. These background spectra are subtracted from the original spectra.  

Note:  While compensation for background will provide more precise purity calculations, it can slow 
down re-analysis of large data files. 

Spectrum Interpolation 
 
Spectrum interpolation may be performed on a spectrum as a result of the settings on 
the Spectrum tab of PDA Options or by doing a right mouse click in the Spectrum 
window and then selecting Operations followed by Interpolate. 

Interpolated spectra may not be stored in spectrum libraries.  

The calculation is performed by doing a 10:1 interpolation of the spectrum data points 
using a cubic spline curve fit. This interpolation is performed after the applying any 
spectral filtering option (1st derivative, 2nd derivative or smooth) to the spectrum. 
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Upslope and Downslope Spectra 
 
The upslope and downslope spectra of a peak are identified by calculating the second 
derivative of the portion of the chromatogram containing the peak. The two times at 
which the second derivative plot crosses zero are known as the inflection points. For 
normal peaks (i.e. non-Negative peaks), the Upslope Spectrum is the spectrum at the 
time represented by the first inflection point, while the Downslope Spectrum is the 
spectrum at the time represented by the second inflection point. 

Spectrum Operations 
 
The following table describes what operations can be done on what type of spectra 

 

 Raw Spectra (no filtering 
or operations) 

Smoothed, 1st Derivative and 
2nd Derivative Spectra  

Interpolated Spectra 

Search against 
Libraries 

Yes 

Similarity  Yes 

Peak Identification 
using spectral 
confirmation 

Yes, but generate an error if the operations that were performed on the reference 
spectrum do not match the current method. 

Appear in Reports Yes Yes, but label must include what operations were 
performed 

Purity Yes No. 

Add to Spectrum 
Library  

Yes No 

Spectrum Smoothing 
 
Spectrum smoothing may be performed on a spectrum as a result of the settings on the 
Spectrum tab of PDA Options or by doing a right mouse click in the Spectrum 
window, and then selecting Operations followed by Smooth. 

Smoothing may be performed repeatedly on a spectrum.  

The calculation is performed by doing a 9 point Savitsky-Golay smooth on the spectrum 
data points.  

Spectrum Derivatives 
Calculation of the 1st and 2nd derivatives of a spectrum may be performed on a 
spectrum as a result of the settings on the Spectrum tab of PDA Options or by doing a 
right mouse click in the Spectrum window, and then selecting Operations followed by 
1st or 2nd Derivative . 

Derivatives may be computed repeatedly on a spectrum.  

The absorbance values of the 1st derivative of a spectrum are computed by calculating 
the differences between adjacent absorbance values to create a new spectrum. The 2nd 
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derivative of a spectrum is defined as the 1st derivative of the 1st derivative of the 
spectrum. 

Library Search Calculations 

General 
During analysis, if one or more search libraries are defined on the Library tab of PDA 
Options, then an automated library search is performed on every integrated peak of 
every PDA analysis channel. 

Note:  Unless a Library Search Results object is part of the method custom report, no 
automated library searching will done when analysis is performed. 

In this section, a Query Spectrum is defined the unknown spectrum that is being 
searched. A Reference Spectrum is defined as a spectrum from a spectrum library file. 

During a search, the apex spectrum of the peak (the query spectrum) is compared to 
each spectrum contained in the libraries (reference spectra) to determine the similarity 
of the query spectrum to the reference spectrum. The similarity is quantified through 
the calculation of a Similarity Index for each query/reference pair. The Similarity 
Indices are used to generate a hit list of the best matching entries. A perfect match will 
have a Similarity Index of 1.0000. Similarity indices less than 1 indicate differences in 
the spectral patterns.  

If the query spectrum and the reference spectrum have different wavelength ranges, 
then the intersection of the two ranges is used in the similarity calculation. 

If the query spectrum and the reference spectrum have different wavelength steps, then 
the higher resolution spectrum is de-resolved to match the other spectrum before being 
used in the similarity calculation. 

Pre-Filters 
 
A pre-filter is a criterion on a reference spectrum that must be met before that 
spectrum is used in similarity calculations. One or more pre-filters may be specified in 
the search parameters. When multiple pre-filters are specified, a reference spectrum 
must meet all of the individual pre-filters in order to be considered for similarity 
calculations. 

Reference spectra that do not meet all of the pre-filter criteria are automatically 
excluded from calculations and from being a candidate for a hit list. No similarity 
calculation is performed on these spectra. 

The following pre-filters are supported: 

Retention Time Range:   When a Retention Time Range is specified, a reference 
spectrum is excluded unless the retention time for the 
spectrum in the library is within the specified range. 

Lambda Max:                 Up to three Lambda Max values may be specified. When one or 
more Lambda Max values are specified, a reference spectrum is 
excluded unless all of the specified maxima are within 5 nm of 
a maxima for the spectrum in the library. 

Compound Name:          When a Compound Name is specified, a reference spectrum is 
excluded unless the specified string is a case-insensitive sub-
string of the compound name for the spectrum in the library. 
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Ratio Chromatogram Calculation 
 
The ratio chromatogram plot consists of data points calculated as follows: 

Ratio Pt. = abs1 / sqrt(abs1 * abs1 + abs2 * abs2) 

where: abs1 = the absorbance in chromatogram 1 at this wavelength 

 abs2 = the absorbance in chromatogram 2 at this wavelength 

 
If the absorbance of any point in chromatogram 1or chromatogram 2 is less than the 
threshold, the Ratio Pt. for that wavelength is set to 0. 

Similarity Calculations 
 
The Similarity Index (SI) compares two spectra across the wavelength range defined in 
Method > PDA Setup > Library. A Library Search is performed using the Similarity 
Index, determined as follows: 

A spectrum is considered as an array of absorbances at each wavelength. 

  (a (λ1), a (λ2), ...., (a (λn)) 

Where a(λi) is the absorbance at λi

The spectrum can also be represented as an n-dimensional vector, with each 
absorbance corresponding to one dimension of the vector, as follows: 

S = (a (λ1), a (λ2), ...., (a (λn)) 

When two spectra are obtained from the same compound, the ratio between 
corresponding elements in S1 and S2 is constant; consequently, the vectors have the 
same direction. In such a case, the angle between the two vectors would be 0. As a 
general rule, the greater the angle between the two vectors, the less similarity they 
have. This relationship is calculated as follows: 

 

The closer the SI value is to 1, the more similar two spectra are considered to be. Two 
spectra are considered to be identical when the SI value is close to 1. 

Lambda Max/Min Calculations 
 
A lambda max (min) is defined as a local maximum (minimum) of the absorbance 
values of a spectrum. The user must define the wavelength range over which the 
calculation should be performed. 

To compute n lambda max (min) values for a spectrum, the software will find the n 
local maxima (minima) with the largest (smallest) absorbance values.  

The calculation range of Lambda Min/Max is based on the X-axis settings for the graph 
in the Axis Setup� context menu item of the graph. 
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Peak Purity Calculations 
 
The purity of a peak is calculated by comparing each spectrum in the peak to the apex 
spectrum using the calculation given in the Similarity Calculation section. To derive a 
purity number, the peak area under the spectra whose similarity meets the purity 
threshold will be divided by the total area of the peak. 

Calculating Total Purity 
 
Total purity for an integrated peak is calculated as follows: 

1. The purity calculation range of the peak is determined by starting from the 
peak apex and working toward peak start and peak end. Each chromatographic 
point in the peak is compared to the absorbance threshold. The start and stop 
values of the range are defined as the point at which the absorbance drops 
below the absorbance threshold. 

2. For each point in the calculation range, a similarity index is calculated by 
comparing the spectrum for that point to the peak apex spectrum. 

3. All spectra whose similarity index meets or exceeds the Purity Threshold will 
be considered similar to the apex spectra. 

4. A sum is calculated of the chromatographic area represented spectrally similar 
points. 

5. The Purity Index is calculated by dividing this sum by the total area over the 
calculation range of the peak.   

6. The purity index will have a range of between 0.000000 and 1.000000.  

Three Point Purity 
 
Three Point Purity is calculated by comparing the spectrum at the apex of a peak (Point 
1) with the spectra at the up-slope (Point 2) and down-slope (Point 3) of the peak.  The 
up-slope spectrum is defined as the spectrum located 20% of the distance from the peak 
start to the peak apex. The down-slope spectrum is defined as the spectrum located 
20% of the distance from the peak end to the peak apex.  These two similarity indices 
are then averaged to get the 3-point purity value. 

 Time up = Time start + (Time apex � Time start) * 1/5 

 Time down = Time apex + (Time end � Time apex) * 4/5 

Similarity indices are generated for the up-slope and down-slope spectra, relative to 
the apex. Since spectra taken at different points along a pure peak will look identical, 
they will have high similarity indices. The closer the Similarity Index is to 1.0000, the 
more similar or more pure the peak is deemed to be. 

While it is easy to decide that a peak with a very low Purity value (0.0000-0.8900) is 
indeed not pure, it is more difficult to decide whether peaks with purity values 
between 0.9000 and 0.9500 are actually contaminated. The user's judgment is required 
to make this determination and may necessitate using other methods to determine 
purity, such as overlaying the spectra or comparing first and second derivatives. 
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